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Creating a chart with Microsoft Excel 2013 (Biology)

After you complete all the instructions in this handout you should be able to:
1. Create a graph using the new Excel 2013 version.
2. Understand the terms used in creating a chart.
3. Make changes and customize a graph.
4. Construct a graph that looks like Figure 1.1 below.
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Figure 1.1 Sample Computer graph using Excel 2013

1. To begin, double-click Microsoft Excel icon on the desktop. Excel will automatically open a

clean Excel sheet similar to figure 1.2 below.
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Figuré 1.2 An Excel worksheet

Handouts are available online at http://www.hagerstowncc.edu/Isc/resource-center




The data table below contains the data that you will be using in this exercise. Volume will be the
independent variable (X axis) and Pressure will be the dependent variable (Y axis).

Age (years) Breathing Capacity
(average % remaining)

25 100

30 98

35 94

40 90

45 80

50 67

55 64

60 62

65 54

70 48

75 44*

80 46

Table 1.1

*Note that the smallest number is not always the last number on the table.
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2. Incell Al of new Excel sheet, type Age (years) and in cell B1, type Breathing Capacity

(average% remaining).

Adjust the width of the column if needed. To do this: see boxed instructions above.

Enter the data from table 1.1 in the appropriate cells.
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3. Use your mouse to highlight the cells that contain data as shown in Fig 1.5
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4. Convert the data table into a chart by clicking on the Insert tab (figure 1.6)
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The insert tab contains the charts group with a variety of charts you can choose from.

For this graphing lab, you will click on scatter, then choose scatter (markers only, no lines).
(Figurel.7).

A screen tip displays the chart type name when you wave the pointer over any chart type.
The screen tip also provides information of the chart type and when to use each one.
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Figure 1.7



Note: If you want to change the chart type after you create your chart, click inside the chart. On the
Design tab under Chart Tools, in the Type group, click Change Chart Type, and select another chart

type.

4. The graph on the Excel sheet should appear similar to Figure 1.8
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Figure 1.8
Adding a Title:

5. Now it’s time to add descriptive titles to your graph so that anybody who views it will know
what the graph is all about.
There are two ways to insert your title:
A. One way is to click the Design tab, then go to Add Chart Element. Click the more

button (mini arrow on the right) to see all the elements that you can add. Each
option provides features that change the way graph components (X axis & Y axis)
are laid out and what information they supply. In this case you would select first
Chart Title, followed by Axis Titles (twice, once for Primary Horizontal, the
second for Primary Vertical).

Another way is to click the Design tab, then go to Quick Layouts. Click the more
button (mini arrow on the right) to see all the layouts. Each option shows different
layouts that change the way graph components (X axis & Y axis) are laid out.

Example: Layout # 1 adds placeholders for a chart and axes titles. It also adds a
legend, which can be deleted in this case, since we have only one line. You will then
type the titles directly on the chart.



C. The other choice is to use the Add Chart Element icon (the large + beside the
chart), which offers many of the same options as the Add Chart Element button
from part ‘A’ of this section.
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6. Adding titles for the chart and axes:

A. Inthe Chart title box, type in the title for the graph: Breathing Capacity As a
Function of Age.

In the Horizontal axis title box, type in the title for the graph: Age (years).

B.
C. Inthe Vertical axis title box, type in the title for the graph: Breathing Capacity
(Average % remaining).

When finished, your chart should look similar to Figure 1.10.
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Figure 1.10

7. Click on the other different buttons or checkboxes (Axes, Gridlines, legend and data labels) to
customize the graph. Below are some of the more commonly used categories:

Chart Title and Axis Title: These categories will allow you to type in your title and label your
dependent and independent variables.

Axes: This option allows you to add, change or remove values on the x or y axes.

Gridlines: This image will allow you to adjust the gridlines on the graph.

Legend: Opening this category will allow to deselect or keep the legend. It will also allow you to
adjust the position of the legend on the page.

Data Labels: Clicking this tab will allow certain properties of each data point to show up on the
graph. Nothing needs to be done here.

8. To Format Axis, under the Add Chart Element option (using either the button on the design
ribbon or the + beside the chart), hover over the axes option (under the button) or click the arrow to
the right (under the +) and choose more axis options. The ‘Format Axis’ menu appears to the right
(figure 1.11). Left click on the number scale beside the desired axis (X or Y) to choose which axis
you want to format (figure 1.12).
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The ‘AXIS OPTIONS?” section allows you to modify the position of the axis and its numbering
scale. The ‘TICK MARKS?’ section allows you to modify the numeric degradations on the axis.
The ‘NUMBER’ section allows you to convert between different types of numerical units (currency,
date, time, percentage, etc.). For other options (like color, fill, effects and line size), explore the
paint bucket, pentangle and size Icons under the ‘AXIS OPTIONS’ heading.
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scale to modify that axis.

Complete all the axis options inside the format axis box as follows: See Table 1.2

X-axis Y-axis
(Independent Variable) (Dependent Variable)
Axis Options
Minimum 20.0 30
Maximum 90.0 110
Major unit 5.0 10.0
Minor unit 1.0 2.0
Values in reverse order | -- --
Logarithmic scale -- --
Major tick mark type Cross Cross
Minor tick mark type inside inside
AXxis labels Next to axis Next to axis
Vertical/ Horizontal axis
Crosses:
Axis value 20.0 30
Number
Category General General
Format code General General
Fill Automatic No Fill
Line Color Solid Line Solid line
Line Style 0.75 pt 0.75 pt
Shadow -- --
3-D Format -- --
Alignment horizontal horizontal

Table 1.2




When finished your ‘FORMAT AXIS’ menu should look like Figure 1.13 and your chart should
look like Figure 1.14 (the x-axis menu is on the left; the y-axis menu is on the right).
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Figure 1.13 Format Axis window after modifications



9. To Format the Plot Area.
]
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Figure 1.14 Chart after modifications

If you did not close out the ‘FORMAT AXIS’ menu, Position cursor on clear region of the graph
(see Click here box in Fig 1.14) then left click; the menu will change from ‘FORMAT AXIS’ to
‘FORMAT PLOT AREA’ . If you did close out the menu, then right click instead. A pull-down

menu will appear, click Formal Plot Area.

Delete
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Change Chart Type

Select Data ...

3-D rotation

Format Plot Area

A ‘FORMAT PLOT AREA’ menu will appear on the screen similar to figure 1.15
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The Format Plot Area Box has the following selections:

We will use mainly the options under the paint bucket icon:

Fill: Allows you to select the background pattern for the plot area.

Border color: Allows you to select the style, color, and weight of the line around the plot area.
Explore the options under the Effects Pentangle icon: allow you to adjust various effects, like
Shadow, Glow, Soft Edges, and 3-D Format.



10. To format the data points and the line which connects them, position the cursor on the data
points or the line and click it (or right click and choose ‘Format Data Series’, if you’ve closed the
menu). If you had to right click, a pull-down menu will appear that will allow you to choose Format
Data Series.

Delete

Reset to Match Style
Change Series Chart Type
Select Data .....

3-D Rotation...

Add data Labels

Add Trendline ...

Format Data Series...

The ‘FORMAT DATA SERIES’ menu will appear on the screen. See figure 1.16, left hand side
shows the options for formatting the line and the right hand side shows the options for formatting the
markers (under the ‘LINE’ and ‘MARKER’ options)
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Figure 1.16 Format Data Series window



There will be several selections inside the ‘FORMAT DATA SERIES’ Menu, but we will use
mainly the submenus ‘LINE’ and ‘MARKER’ under the Paint Bucket Icon. Most of these are
similar to the options we’ve used previously (Fill, Border, Shadow, Glow, etc), but of special
interest is the ‘Marker Options’ choice, which allows you to change the shape of your data points in
the graph.

11. You may customize your data points as you prefer.

Line: Choose none followed by the style, color, and weight that you like. The appearance of the line
will appear under sample if you choose custom.

Marker: This will format the symbol for each data series. Choose the shape of the symbol that you
like best. If you choose the same color for the foreground and background, the symbol will be filled
and solid. If you choose a dark color for the foreground with light color (white) for the background
the result is an open symbol.

The other choices do not apply to this data but feel free to click these tabs to be familiar.
12. To make a line of best fit by adding a trendline, use the following steps.

Position your arrow on the data points then, right-click.
A pull-down menu will be displayed on the screen similar to this.

Delete

Reset to Match Style

Change Series Chart Type

Select Data .....

3-D Rotation...

Add data Labels

Add Trendline ...

Format Data Series...

Go down to Add Trendline and click.
To format trendline: right click the trendline then select format OR
Use the + beside the chart, then trendline, then select more options.
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The ‘FORMAT TRENDLINE’ menu will appear on the screen (figure 1.17) from which you can
choose the type of Trendline you desire for your graph.

Under Trendline Options choose Linear.
(Optional): You may also choose the ‘Display equation on chart’
and the ‘Display R-squared values on chart’
to display data analysis information.



Under Fill and Line (the paint bucket) options choose Solid Line and fill in any other options that
you wish.
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13. To add your name:

Select the graph by clicking on a blank space.

Click on the Insert tab then click on the down arrow under Text and choose Header & Footer
(Figure 1.18).

The Page set-up box will be displayed. See Figure 1.19
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Figure 1.18 Finding and opening the Header Menu.
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Figure 1.19 Page Set-up box

Click Custom Header and the Header box will appear.



Header

To format text: select the text, then choose the Format Text button. L\\}J

Toinsert a page number, date, time, fle path, flename, or tab name: position the
insertion point in the edit box, then choose the appropriate button.

Toinsert picture: press the Insert Picture button. To format your picture, place the
cursor in the edit box and press the Format Picture button.

Left section: Center section: Right section:

Ok ] ’ Cancel

Figure 1. 19 Header window

Type your name and other information required by your instructor in the left section.

Leave other sections as is (unless instructed otherwise by your instructor).
Click OK twice.

14. To print your graph.

Choose the FILE menu on the top left corner of the screen.

In the new menu, click print and then print again to print your graph (Figures 1.20 and
1.21).
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Figure 1.21

Caution: Do not close until you have your print-out!
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Figure 1.22: Your finished graph, complete with header.
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